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Section 1

Introduction

The AP (IEEE 802.11 HR, 11 Mbps WLAN Access Point) is a long-range, high
performance LAN product, which provides Access Point services to a 2,4 GHz RF net-
work and bridges to an Ethernet backbone. The design of this product is based on
AT76C510 (bridge-on-a-chip) module, a highly integrated ASIC designed to combine
legacy LANs with wireless LANs. AT76C510 performs all the necessary inter-network-
ing and bridging functions. It receives data from both networks, stores them locally for
further processing, installs and maintains connections and transmits the packets to the
proper destination. Furthermore, AT76C510 interfaces three more modules, the Ether-
net PHY, the wireless PHY and the RAM modules, for allowing compact system
implementation and flexibility for supporting almost all the possible physical interfaces.

This document describes the steps required for the initial set up of the AP IP address,
the AP configuration, and the firmware upgrade procedure. The description includes the
implementation of the above steps through both Ethernet and USB.

1.1 Package
Contents

Please make sure that you received the following with your AT76C510-Development Kit:
» One Bridge Access Point board

* One MACIess Radio card
» User Guide
* Firmware, Drivers, and Software Tools CD

1.2 System
Requirements

For configuration through USB:
+ Operating System: MS Windows® 98

» Desktop PC or notebook PC with USB port
* USB cable
e 4.5-5V (regulated)-1Amp power supply cable

For configuration through Ethernet:
« Operating System: MS Windows® 98, Windows® 2000, Windows® NT 4.0

» Desktop PC or notebook PC connected on a LAN
+ Ethernet cable
» 4.5-5V (regulated)-1Amp power supply cable

1.3 AT76C510
Features

11

Among the features of the AT76C510 bridge-on-a-chip are the following:
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Introduction

— Glueless connection to Intersil PRISMI, PRISMII Direct Sequence Spread Spectrum
(DSSS) radio chip set. Able to communicate also with other DSSS radios

— Supports 11, 5.5, 2 and 1 Mbps rates

— WEP encryption/decryption is accomplished on the fly

— Ethernet MAC supports Mll interface and 10/100Mbit speeds

— Hardware modules for Packet Filtering and statistics gathering

Glueless SRAM, Flash interface for data buffering and program storage, supporting

up to 16 MB of memory

— Integrated 2 x 6K x 32 bit internal SRAM modules for fast 32-bit program execution
and temporary storage of data

— Supports 3V supply

— 128-pin PQFP, TQFP

— JTAG Boundary Scan (IEEE 1149.1) test access port for board-level production test

14 Firmware The IEEE 802.11 HR firmware implementation for the supports:
Features — Distributed Coordination Function
CSMAI/CA

Backoff Procedure

NAV Management

ACK Procedure

Retransmission of unacknowledged frames
RTS/CTS Handshake
Duplicate Detection and Recovery
— Beacon Generation
Probe Response
Fragmentation and Reassembly
— Wired Equivalent Privacy Algorithm (WEP 40 bits)
— Authentication Algorithm (Open System, Shared Key)
— Short Preamble

15 Bridging The following bridging functions are supported:
Functions — Automatic Learning Process

Filtering Database

Forwarding Process

Protocol Filtering

IP Filtering

1.6 Management For Bridge Management supports:
— SNMP (MIB, traps)
— TFTP (firmware download)
— USB (DFU-configuration)

1.7 Roaming Roaming functions supported:
— Among APs on the same subnet

1.8 Operation Modes Operation Modes supported:
— Access Point

1.9 Network AP supports 10/100 Mbps network interface.
Interface

1.10 Radio Interface As far as the radio interface is concerned, AP supports:
— Antenna Diversity
— Specific Antenna Tx/Rx

12 AIMEL
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Section 2

The AP Development Board

Figure 2-1 shows the Access Point development board. The basic fea-
tures of this board are outlined below:

« Interfaces directly to 10/100 IEEE 802.3 Ethernet networks.

» Supports IEEE 802.11b (High data rate) WLAN functions.

» Firmware is stored in a flash memory and can be upgraded remotely.
» Single 5V 1Amp universal power supply.

» Configurable through Ethernet and USB ports.

» Power and wireless activity LED indicators.

The MACless Radio card required is shown in Figure 2-2.

Figure 2-1. AP development board

2-1
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The AP Development Board

Figure 2-2. MACless Radio

Wireless LAN

74GHz D555
MACIess Radio
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Section 3

Setting the IP Address of the Access
Point

The first step in using the AP is to set its IP Address. This procedure can be
done either through the Ethernet port by using a combination of Arp/Ping commands
and the SNMP Manager, or the USB port by using the DFU utility.

3.1 Using the In order to set the Access Point IP address you need to know the Access Point MAC
Ethernet Port address. Follow the steps below giving the Access Point a temporary address at the
beginning (Step A) and saving the IP address through the SNMP Manager application

(Step B).

Step A:

1. Connect an Ethernet station and the Access Point on the same subnet. The sim-
plest way to accomplish that is to connect the Access Point and the Ethernet
station to the same hub. You need to check if the station IP address and the Sub-
net mask are configured properly. Also the new IP address for the Access Point
must correspond to the Subnet mask.

2. Open a MS-DOS Prompt window and enter a static route in the arp table for the
new IP address you want to assign. Use the arp -s command to do that:

arp -s "new-1P-address" "AP-MAC-address"
For example: arp -s 10.170.254.27 00-00-22-22-22-25
3. Ping the Access Point, using its new IP address.
For example: ping 10.170.254.27

4. If you get a ping reply, then the IP address has been temporarily set. In order to
set it permantly you need to proceed to Step B without powering off the Access

Point.

Step B:

1. Execute the SNMP Manager application using the IP address as set above (Step
A).

2. Save the current configuration through the SNMP Manager application.

3. Open the SNMP Manager application, select “Connect AP-Bridge” option under
the “File” menu. Try to connect to the Access Point, by typing its IP address in
the panel which appears and at the Community field, type "public" and then

3-1




Setting the IP Address of the Access Point

press OK. Type the IP address in the “IP Configuration” window under the
“Setup” menu, “Bridge” submenu. In order to save the configuration select
“Download Changes” under the “File” menu. See also the paragraph “Using the
SNMP Manager” in the section “Access Point Configuration”.

3.2 Using the USB Note: This procedure requires the use of the DFU Configuration Utility which can be
Port used only through the USB port. When you connect the card to the USB port for
the very first time, the operating system will ask for the driver of the card. Please
locate the driver into your CD. At this time, only a driver for MS Windows 98 is
available. After you have completed the installation of the driver, you can use
the DFU Configuration Utility.

In order to configure the AP IP address through the USB port, you must use the
DFU Configuration Utility.

Plug the USB cable to the Access Point USB port. Open the application DFU.exe which
you will find in the “Utilities” folder of your CD and select the “Configuration” button (Fig-
ure 3-1).

Figure 3-1. DFU Configuration Utility

P Bridge LHlity Application

Code Dirwnload
Firrerweare File

Download

Lhiliie=

i Carili st

[P o

Press the “Get” button (Figure 3-2) if you want to view the current IP address. If you
want to set a new IP address, first type the new IP address in the “Ethernet IP Address”
field in the configuration window that is already opened, and then select the “Set” com-
mand. In order to set the new parameters you need to wait for a few seconds for the
completion of this process.

22 AIMEL
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Setting the IP Address of the Access Point

Figure 3-2. DFU Utility Bridge Configuration window
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Section 4
Access Point Configuration
The AP configuration can be done either through the Ethernet port by using the
SNMP Manager application, or the USB port by using the DFU Utility.
4.1 Using the In order to configure the AP through the Ethernet port, you must first install the

41.1

4.1.2

4-1

Ethernet Port

How to Install the
SNMP Manager

Using the SNMP
Manager

SNMP Manager application, which is a powerful and reliable tool used for the remote
configuration of the Access Point through the Ethernet port.

In order to install the SNMP Manager you need to extract the “SNMPManager.zip” file,
which you will find into the “Utilities” folder of your CD, in a temporary file and then run
the program “setup.exe”. Follow the instructions of the set-up program and select the
directory where the application will be installed. Finally, a window will appear indicating
the completion of the installation.

Note: Before using the SNMP Manager for configuring the AP, verify that the
Access Point IP address has been set-up following the procedure described in
the section “Setting the IP Address of the Access Point”.

On the Start Menu, select SNMP Manager. When the application opens, select
“Connect AP-Bridge” option which is under the “File” menu. Try to connect to the Access
Point, by typing its IP address in the panel which appears and at the Community field,
type "public" and then press OK (Figure 4-1).
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Figure 4-1. Connecting to the AP using the SNMP Manager
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In case of a successful connection to the Access Point, the following window appears
(Figure 4-2). Press “OK".

Figure 4-2. Agent found

Agent found

ATMEL ‘wirgless Network [Mer 1.00]

In case of an unsuccessful connection you receive the following message (Figure 4-3):

Figure 4-3. Agent not found

AtmelM anager E

ATMEL Wireless Network nat found...

If the above error message appears, you need to check if the AP has the desired IP
Address and is connected to the network. In order to check the validity of the IP Address
you need to ping the AP.

AIMEL
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Access Point Configuration

When the connection has successfully been established, you get a message in the right
bottom corner indicating “All values retrieved”. If the message “Not all values retrieved”
appears, you need to repeat the above procedure (Figure 4-1).

As soon as the connection has been established, you are now able to start viewing or
setting the Access Point parameters. Under the “Setup” menu, there are three options
available (Figure 4-4):

» Bridge
* Wireless LAN
» Enable SNMP Traps

Figure 4-4. SNMP Bridge menu and submenus

EF:E‘” Lgurailm
Qperational Mode

[Trap Recelved AERIREL [Trap Received

Under the “Bridge” option, there are two submenus: “IP Configuration” and “Operational
Mode”. The “Ethernet Address”, “IP Configuration” and “IP Mask” can either be viewed
or changed through the “IP Configuration” (Figure 4-5). If changes are made, you need
to “Download Changes” under the “File” menu in order to save them.

ATMEL
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Figure 4-5. Bridge IP Configuration window

ATHMEL SNMP Manager
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1P Mask [zm5255.255.0
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You also need to check that the “Access Point” option is enabled under the “Operational
Mode” submenu (Figure 4-6).
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Figure 4-6. Bridge Operational Mode window

&% Bridge Operational Mode

[All values retrieved. SAlmEL /

Under the “Wireless LAN” option, the following submenus are available (Figure 4-7):
» Phy params

* Privacy Options
» Operational settings

ATMEL
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Figure 4-7. SNMP Wireless LAN menu and submenus
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Phy Params (Figure 4-8):
» Channel: Select the channel to be used. There are 14 channels available.

» Rate: Select the rate to be used among the following options 1 Mbps, 2 Mbps, 5.5
Mbps and 11 Mbps.

ATMEL
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Figure 4-8. Wireless Physical Parameters window

~ ATMEL SNMP Manager

o

High (11 Mbit/sec]

Cancel |

[All values retrieved. SAlmEL /

Privacy Options (Figure 4-9):
There are four 5 Hex digit encryption keys available, and you must define the value of

the key of your choice. This key is enabled only if the you select it in the “Default key”
option. Enable the WEP (ON/OFF) option in order to activate WEP encryption.

ATMEL
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Figure 4-9. Wireless Privacy Options window

WEP (ON/OFF) [

ok | cancel |

[All values retrieved. AlmEL

Operational Settings (Figure 4-10):

ESSID: Select the ESSID to be used.

Fragmentation: This is the option for the Fragmentation Threshold activation.
RTS Threshold: This is the option for the RTS Threshold activation.
Authentication Type (Open System, Shared Key, Both).

Preamble Type (Short, Long).

ATMEL
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Figure 4-10. Wireless Operational Settings window
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Under the “Setup” menu you can either enable or disable SNMP traps, which are mes-
sages displayed in the right bottom corner indicating that an action related to the AP -
Bridge took place, such as:

» Trap Reassociation: This trap message is sent when a Station’s reassociation request
is received from the AP - Bridge.

» Trap Assaociation: Indicates the reception of an association request packet and the
sender Station's successful association with the Wireless Bridge.

» Trap Disassociation: This trap message is sent when a disassociation notification
packet is received from a Station.

» Trap Reset: This trap message is sent when the AP-Bridge resets.

» Trap Setting IP Address with Ping: This trap message is sent when the AP-Bridge IP
address is set with the transmission of a ping message.

» Trap Start Up: This trap message is sent when Bridge starts up.

» Trap Failed To Erase Flash: This trap message is sent when Bridge fails to erase
flash.

You can see additional information for every Trap Message by selecting the “View
Record” option under the “Traps” menu.

In order to “Reset Device” or “Restore Defaults” you need to select the appropriate sub-
menu under the “Commands” menu.

AIMEL
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4.1.3

4.2

4-10

How to Uninstall the
SNMP Manager

Finally, the “Info” menu contains “Wireless and Ethernet Statistics”.

In order to uninstall SNMP Manager you must go to the ‘Control Panel” (“Start-
>Settings->Control Panel”) and press the “Add/Remove Programs” button. Select the
application from the list and press the “Add/Remove...” button. Press “Yes” when asked
whether you want to remove this program and its components. A window indicating the
uninstallation progress appears.

Using the USB
Port

Note: This procedure requires the use of the DFU Configuration Utility which can be
used only through the USB port. When you connect the card to the USB port for
the very first time, the operating system will ask for the driver for the card.
Please locate the driver into your CD. At this time, only a driver for MS Windows
98 is available. After you have completed the installation of the driver, you can
use the DFU Configuration Utility.

In order to configure the AP through the USB port, you must use the DFU Con-
figuration Utility.

In order to change or view the Bridge parameters you have to plug the USB cable and
then open the DFU.exe application which you will find into the “Utilities” folder of your
CD.

By pressing the “Configuration” button in the main dialog box (Figure 4-11) the Bridge
Configuration dialog appears (Figure 4-12).

Figure 4-11. DFU Configuration Utility

P Bridge LHility Application

Code Download
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Dicwrioad

Lhilies

i Carfliguraton

Fadio Test

AIMEL




4-11

Access Point Configuration

Figure 4-12. DFU Utility Bridge Configuration window
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The current parameters of the Bridge can be retrieved by pressing the “Get” button in
the Bridge Configuration dialog. You can update the bridge configuration parameters by
setting them first and then selecting the “Set” button.

Network Parameters:

Ethernet IP Address: The IP Address of the AP

Ethernet Subnet Mask: The Ethernet station and the Access Point must be on the
same subnet. The IP address for the Access Point must correspond to the Subnet
Mask.

Ethernet MAC Address: The MAC address of the AP.

802.11 Parameters:

Channel: Select the channel to be used. There are 14 channels available.

Rate: Select the rate to be used among the following options: 1 Mbps, 2 Mbps, 5.5
Mbps, and 11 Mbps.

ESSID: Select the ESSID to be used.

Fragmentation Threshold: This is the option for the Fragmentation Threshold
activation.

RTS Threshold: This is the option for the RTS Threshold activation.

AIMEL
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» Preamble Type: Select Short or Long Preamble Type.

» Authentication Type: Select Open System or Shared Key Authentication Type.
WEP Keys:
* WEP Key #1-#4: Set the value of the WEP key. WEP keys must be in HEX and in two

bytes per character format e.g. if you want the WEP Key #1 to be 12345, then you
must set it as 0102030405.

» Default Key: Select which of the four WEP Keys is going to be used. By selecting 0,
no WEP encryption will be used.
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Section 5

Access Point Firmware Upgrade

The AP firmware upgrade can be done either through the Ethernet port by using
the TFTP Client Utility, or the USB port by using the DFU Utility.

51 Using the
Ethernet Port

5.1.1 How to Install the
TFTP Client

51.2 Using the TFTP
Client

5-1

In order to upgrade the firmware of the AP through the Ethernet port, you must
first install the TFTP Client Utility, which is a powerful and reliable tool used for the
remote firmware upgrade of the Access Point through the Ethernet port.

In order to install the Tftp Client Utility you need to extract the given “TFTP.zip” file
which you will find into the “Utilities” folder of your CD, in a temporary folder and then run
the program “setup.exe”. Follow the instructions of the set-up program and select the
directory where the application will be installed. Finally, a window will appear indicating
the completion of the installation.

Note: Before using the TFTP Client for upgrading the firmware of the AP, verify
that the Access Point IP address has been set-up following the procedure
described in the section “Setting the IP Address of the Access Point”.

On the Start Menu, select TFTP. The window of Figure 5-1 appears.

Figure 5-1. Tftp Client Utility

£¥ Tftp Client

IP Address | AImEl
Imane File I |

Download E it |

Type the IP address of the Access Point in the first edit box of the panel. Then, browse
for the file xxxx.rom by pressing the “three dots” button. Finally press the "Download"
button (Figure 5-2).




Access Point Firmware Upgrade

5.1.3

5.2

5-2

How to Uninstall the
TFTP Client

Figure 5-2. Type the IP address, browse for the file bridge.rom and download

B8 Titp Client |

IP Address |1 0.170.254.32

Imane File Il::'\.l:lridge.rnm |

Dawnload E it |

The Firmware Download procedure will be completed successfully if a message in the
right bottom corner appears indicating “Firmware download has been completed”. If you
receive the message “TimedOut”, in the right bottom corner, during the firmware down-
load procedure, you need to check if the Access Point is powered on and if it has a valid
IP address. In order to check the validity of the IP address you must ping the Access
Point.

If you receive the message “Flash Programming in progress” during the firmware down-

load procedure you shouldn’t power off the Access Point. In order to close the
application press the "Exit" button.

Note: If the download procedure has not been completed successfully you must try
again but before starting the download you need to confirm that you are using
the correct firmware file .

In order to uninstall SNMP Manager you must go to the ‘Control Panel” (“Start-
>Settings->Control Panel”) and press the “Add/Remove Programs” button. Select the
application from the list and press the “Add/Remove...” button. Press “Yes” when asked
whether you want to remove this program and its components. A window indicating the
uninstallation progress appears.

Using the USB
Port

Note: This procedure requires the use of the DFU Configuration Utility which can be
used only through the USB port. When you connect the card to the USB port for
the very first time, the operating system will ask for the driver for the card.
Please locate the driver into your CD. At this time, only a driver for MS Windows
98 is available. After you have completed the installation of the driver, you can
use the DFU Configuration Utility.

In order to upgrade the firmware of the AP through the USB port, you must use
the DFU Configuration Utility.

First of all you have to plug the USB cable and then open the DFU.exe application which
you will find into the “Utilities” folder of your CD.

In the main window of the DFU Configuration Utility (Figure 5-5), select the file xxxx.rom,
by pressing the “three dots” button. Finally press the “Download” button.

AIMEL
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Access Point Firmware Upgrade

Figure 5-3. DFU Configuration Utility
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Please keep in mind that this process needs some time to complete. When the DFU
completes successfully a window appears indicating the status of the download (DFU
succeeded, DFU failed). Finally, close the application and unplug the cable.
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INSTRUCTIONS MANUAL
FEDERAL COMMUNICATIONS COMMISSION
INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limitsfor aClass B digitd device,
pursuant to Part 15 of the FCC Rules Theselimitsare designed to provide reasonable
protection againg harmful interference in aresdentid inddlation. This equipment generates,
uses and can radiate radio frequency energy  and, if not installed and used in accordance with
the ingructions, may cause harmful interference to radio communicetions.  However, thereis
no guarantee that interference will not occur in aparticular inddlation. If this equipment does
cause harmful interference to radio or televison reception, which can be determined by turning
the equipment off and on, the user isencouraged totry to correct the interference by oneor
moreof thefollowing messures

-- Reorient or rdocate the recaiving antenna
-- Increase the separation between the equipment and recaiver.

-- Connect the euipment into an outlet on acircuir different from that to
which the receiver is connected.

-- Consault the dedler or an experienced radio/TV technician for help.

CAUTION:

Any changes or modifications not expresdy approved by the grantee of
his device could void the user's authority to operate the equipment.

The antenna(s) used for this transmitter must be ingtaled to provide a separation distance of
a least 20 cm from dl persons and must not be co-located or operating in conjunction with any
other antenna or trangmitter. End- users and ingtalers must be provided with antennalingtalation
ingructions and tranamitter operating conditions for satisfying RF exposure compliance
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RTWO020 AP H/W Specifications

Hardware

Model Type

11Mbps Wireless LAN Access Point

Frequency Band

2400 — 24835 MHz

Number of Allowed 11Ch (for FCC)
Channels 13Ch (for ETSI)
14Ch (for TELEC)
Ethernet interface Support Both Ethernet and 802.3(M ax. Bit rate 10M bps)with
RJ-45 10BaseT connector
Serial interface USB (console port for configuration)
DC Power Adapter DC Power Adapter
AC Input:100V~240V(50~60HZ)
DC Output:5V / 2.0A

Modulation Technique

Direct Sequence Spread Spectrum (CCK, DQPSK, DBPSK)

LED Indicator

Active(Green), Line Link(Green)
Power(Red)

Operational Conditions

Temperature 0-55°C
95%max. Humidity (no condensation allowed)

PCB Dimensions

116.77mm(L)* 75.47mm(w)

Antennatype

2 External Antenna

Average Output Power

20dBm

Power Consumption

Rx :780mA Tx:1.2A

Standards

|EEE 802.11b, Wi-Fi —Certified
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